Contents

Chapter 1  Overview
  Technical Support ................................................................. 1-1
  About This Document ....................................................... 1-2
  Purpose .............................................................................. 1-2
  Audience .......................................................................... 1-3
  Document Organization ...................................................... 1-4
  Notational Conventions .................................................... 1-5

Chapter 2  Getting Started with Intel® IPP
  Intel IPP Basics ................................................................. 2-1
  Cross-Architecture Alignment ........................................... 2-2
  Types of Input Data .......................................................... 2-2
  Domains ............................................................................ 2-4
  Function Naming and Parameters ...................................... 2-5
  Checking Your Installation ................................................. 2-8
  Obtaining Version Information .......................................... 2-9
  Building Your Application ................................................ 2-9
    Setting Environment Variables ....................................... 2-9
    Including Header Files ................................................ 2-10
    Calling IPP Functions .................................................. 2-10
  Before You Begin Using Intel IPP ....................................... 2-12

Chapter 3  Intel® IPP Structure
  High-level Directory Structure .......................................... 3-1
  Supplied Libraries ............................................................ 3-2
Using Intel IPP Dynamic Link Libraries (DLLs)................................. 3-2
Using Intel IPP Static Libraries ......................................................... 3-3
Contents of the Documentation Directory ........................................ 3-4

Chapter 4 Configuring Your Development Environment
Configuring Microsoft* Visual C++* .NET 2003 or Microsoft Visual
C++*2005 Software to Link with Intel IPP ........................................ 4-1
Creating Visual C++ 2005 Project Files for the Intel® IPP Samples 4-2
Building a Microsoft* Visual C++ .NET* Solution for the UMC Sample
Code ................................................................................................ 4-2
Using the IntelliSense* Capability ..................................................... 4-3
Using Intel® IPP with Intel® C++ Compiler ....................................... 4-6
Using Intel® IPP with Borland C++ Builder* Integrated Development
Environment ................................................................................ 4-6

Chapter 5 Linking Your Application with Intel® IPP
Dispatching ......................................................................................... 5-1
Processor Type and Features ............................................................. 5-2
Selecting Between Linking Methods .................................................. 5-4
Dynamic Linking ................................................................................ 5-5
Static Linking (with Dispatching) ....................................................... 5-5
Static Linking (without Dispatching) .................................................. 5-7
Building a Custom DLL ...................................................................... 5-9
Comparison of Intel IPP Linkage Methods ......................................... 5-10
Selecting the Intel IPP Libraries Needed by Your Application .......... 5-10
Dynamic Linkage .............................................................................. 5-12
Static Linkage with Dispatching ....................................................... 5-13
Library Dependencies by Domain (Static Linkage Only) ................. 5-13
Linking Examples .............................................................................. 5-14

Chapter 6 Supporting Multithreaded Applications
Intel IPP Threading and OpenMP* Support ........................................ 6-1
Setting Number of Threads ............................................................... 6-1
Using Shared L2 Cache ..................................................................... 6-2
Nested Parallelization ...................................................................... 6-2
Disabling Multithreading ............................................................... 6-2
Chapter 7 Managing Performance and Memory
- Memory Alignment ................................................................. 7-1
- Thresholding Data ................................................................. 7-3
- Reusing Buffers ..................................................................... 7-4
- Using FFT ............................................................................... 7-5
- Running Intel IPP Performance Test Tool ............................... 7-6
  - Examples of Using Performance Test Tool Command Lines .... 7-7

Chapter 8 Using Intel® IPP with Programming Languages
- Language Support .................................................................... 8-1
- Using Intel IPP in Java* Applications ...................................... 8-2

Appendix A Performance Test Tool Command Line Options

Appendix B Intel® IPP Samples
- Types of Intel IPP Sample Code .............................................. B-1
- Source Code Samples .............................................................. B-2
- Using Intel IPP Samples ......................................................... B-4
  - System Requirements .......................................................... B-4
  - Building Source Code .......................................................... B-5
  - Running the Software ......................................................... B-6
- Known Limitations ............................................................... B-6

Index
Overview

Intel® Integrated Performance Primitives (Intel® IPP) is a software library that provides a broad range of functionality. This functionality includes general signal and image processing, computer vision, speech recognition, data compression, cryptography, string manipulation, audio processing, video coding, realistic rendering and 3D data processing. It also includes more sophisticated primitives for construction of audio, video and speech codecs such as MP3 (MPEG-1 Audio, Layer 3), MPEG-4, H.264, H.263, JPEG, JPEG2000, GSM-AMR, G.723.

By supporting a variety of data types and layouts for each function and minimizing the number of data structures used, the Intel IPP library delivers a rich set of options for developers to choose from when designing and optimizing an application. A variety of data types and layouts are supported for each function. Intel IPP software minimizes data structures to give the developer the greatest flexibility for building optimized applications, higher level software components, and library functions.

Intel IPP for Windows® OS is delivered in separate packages for:

- Users who develop on 32-bit Intel architecture (Intel IPP for the Windows® OS on IA-32 Intel® Architecture)
- Users who develop on Intel® 64-based (former Intel EM64T) architecture (Intel IPP for the Windows® OS on Intel® 64 Architecture)
- Users who develop on Intel® Itanium® 2 processor family (Intel IPP for the Windows® OS on IA-64 architecture)

Technical Support

Intel IPP provides a product web site that offers timely and comprehensive product information, including product features, white papers, and technical articles. For the latest information, see http://developer.intel.com/software/products/.
Intel also provides a support web site that contains a rich repository of self-help information, including getting started tips, known product issues, product errata, license information, and more (visit http://support.intel.com/support/).

Registering your product entitles you to one-year technical support and product updates through Intel® Premier Support. Intel Premier Support is an interactive issue management and communication web site providing the following services:

- Submit issues and review their status.
- Download product updates anytime of the day.

To register your product, or contact Intel, or seek product support, please visit http://www.intel.com/software/products/support/ipp.

**About This Document**

This User’s Guide provides information about how to make the most of Intel® IPP routines using Windows® applications running on IA-32 architecture. It describes features specific to this platform, as well as features that do not depend upon a particular architecture.

After installation, you can find this document in the `<install path>`\doc directory (see [Contents of the Documentation Directory](#)).

**Purpose**

This document:

- Helps you start using the library by describing the steps you need to follow after installation of the product.
- Shows how to configure the library and your development environment to use the library.
- Acquaints you with the library structure.
- Explains in detail how to select the best linking method, how to link your application to the library, and it provides simple usage examples.
- Explains how to thread your application using IPP software.
- Describes how to code, compile, and run your application with Intel IPP.
- Provides information about how to accomplish Intel IPP functions performance tests by using Intel IPP Performance Test Tool.
- Describes types of Intel IPP sample code available for developers to learn how to use Intel IPP and it explains how to run the samples.
Audience

This guide is intended for Windows programmers with beginner to advanced software development experience.
Document Organization

The document contains the following chapters and appendices.

Chapter 1 Overview describes the document purpose and organization as well as explains notational conventions.

Chapter 2 Getting Started with Intel® IPP describes necessary steps and gives basic information needed to start using Intel IPP after its installation.

Chapter 3 Intel® IPP Structure describes the structure of the Intel IPP directory after installation and discusses the library types supplied.

Chapter 4 Configuring Your Development Environment explains how to configure Intel IPP and how to configure your environment for use with the library.

Chapter 5 Linking Your Application with Intel® IPP compares linking methods, helps you select a linking method for a particular purpose, describes the general link line syntax to be used for linking with the Intel IPP libraries, and discusses how to build custom dynamic libraries.

Chapter 6 Supporting Multithreaded Applications helps you set the number of threads in multithreaded applications, get information on the number of threads, and disable multithreading.

Chapter 7 Managing Performance and Memory discusses ways of improving Intel IPP performance and tells you how to create Intel IPP functions performance tests by using the Intel IPP Performance Test Tool.

Chapter 8 Using Intel® IPP with Programming Languages discusses some special aspects of using Intel IPP with different programming languages and Windows development environments.

Appendix A Performance Test Tool Command Line Options gives brief descriptions of possible performance test tool command line options.

Appendix B Intel® IPP Samples describes types of sample code available to demonstrate how to use Intel IPP, presents the source code example files by categories with links to view the sample code, and explains how to run the samples.

The document also includes an Index.
### Notational Conventions

The document uses the following font conventions and symbols:

**Table 1-1 Notational conventions**

<table>
<thead>
<tr>
<th>Font Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Italic</em></td>
<td><em>Italic</em> is used for emphasis and also indicates document names in body text, for example, <em>Intel IPP Reference Manual</em></td>
</tr>
<tr>
<td>Monospace lowercase</td>
<td>Indicates filenames, directory names, and pathnames, for example: \tools\env\ippenv.bat</td>
</tr>
<tr>
<td>Monospace lowercase + mixed with uppercase</td>
<td>Indicates code, commands, and command-line options, for example: ippsFFTGetBufSize_C_32fc( ctxN2, &amp;sz );</td>
</tr>
<tr>
<td>UPPERCASE MONOSPACE</td>
<td>Indicates system variables, for example, PATH</td>
</tr>
<tr>
<td>Monospace italic</td>
<td>Indicates a parameter in discussions, such as function parameters, for example, <em>lda</em>; makefile parameters, for example, <em>functions_list</em>; and so forth. When enclosed in angle brackets, indicates a placeholder for an identifier, an expression, a string, a symbol, or a value: &lt;ipp directory&gt;.</td>
</tr>
<tr>
<td>[ items ]</td>
<td>Square brackets indicate that the items enclosed in brackets are optional.</td>
</tr>
<tr>
<td>{ item</td>
<td>item }</td>
</tr>
</tbody>
</table>
Getting Started with Intel® IPP

This chapter helps you start using Intel® IPP by providing basic information you need to know and describing the necessary steps you need to follow after installation of the product.

Intel IPP Basics

Intel IPP is a collection of high-performance code that provides a broad range of functionality. This functionality includes general signal and image processing, computer vision, speech recognition, data compression, cryptography, string manipulation, audio processing, video coding, realistic rendering and 3D data processing, matrix math. It also includes more sophisticated primitives for construction of audio, video and speech codecs such as MP3 (MPEG-1 Audio, Layer 3), MPEG-4, H.264, H.263, JPEG, JPEG2000, GSM-AMR, G.723.

Based on experience in developing and using the Intel Performance Libraries, Intel IPP has the following major distinctive features:

- Intel IPP provides basic low-level functions for creating applications in several different domains, such as signal processing, audio coding, speech recognition and coding, image processing, video coding, operations on small matrices, and realistic rendering functionality and 3D data processing. See detailed information in the section Domains.
- The Intel IPP functions follow the same interface conventions including uniform naming rules and similar composition of prototypes for primitives that refer to different application domains. For information on function naming, see Function Naming and Parameters.
- The Intel IPP functions use abstraction level which is best suited to achieve superior performance figures by the application programs.

To speed up performance, Intel IPP functions are optimized to use all benefits of Intel® architecture processors. Besides, most of Intel IPP functions do not use complicated data structures, which helps reduce overall execution overhead.
Intel IPP is well-suited for cross-platform applications. For example, the functions developed for IA-32 architecture-based platforms can be readily ported to Intel® Itanium®-based platforms (see Cross-Architecture Alignment).

**Cross-Architecture Alignment**

Intel IPP is designed to support application development on various Intel® architectures. This means that the API definition is common for all processors, while the underlying function implementation takes into account the variations in processor architectures.

By providing a single cross-architecture API, Intel IPP allows software application repurposing and enables developers to port to unique features across Intel® processor-based desktop, server, and mobile platforms. Developers can write their code once in order to realize the application performance over many processor generations.

**Types of Input Data**

Intel IPP operations are divided into several groups in dependence on the types of input data on which the operation is performed. The types for these groups are:

- **One-Dimensional Arrays and Signals**
  This group includes most functions operating on one-dimensional arrays of data. In many cases these array are signals and many of the operations are signal-processing operations. Examples of one-dimensional array operations include:
    - vectorized scalar arithmetic, logical, statistical operations
    - digital signal processing
    - data compression
    - audio processing and audio coding
    - speech recognition and speech coding
    - cryptography and data integrity
    - string operations

- **Images**
  An image is an two-dimensional array of pixels. Images have some specific features that distinguishes them from general two-dimensional array. Examples of image operations include:
    - arithmetic, logical, statistical operations
    - color conversion
    - image filtering
    - image linear and geometric transformations
morphological operations
computer vision
image compression
video coding

Matrices
This group includes functions operating on matrices and vectors that are one- and two-dimensional arrays, and on arrays of matrices and vectors. These arrays are treated as linear equations or data vectors and subjected to linear algebra operations. Examples of matrix operations include:
  - vector and matrix algebra
  - solving systems of linear equations
  - solving least squares problem
  - computing eigenvalue problem

3D objects
This group includes functions operating with 3D objects. In this case input data depends on the used techniques. Examples of 3D operations include:
  - realistic rendering
  - resizing and affine transforming

The Intel IPP functions are primarily grouped according to the input data types listed above. Each group has its own prefix in the function name (see Function Naming).

Core Functions
A few service functions in Intel IPP do not operate on one of these input data type. Such functions are used to detect and set system and Intel IPP configuration. Examples of such operations include getting the type of CPU, aligning pointers to the specified number of bytes, controlling the dispatcher of the merged static libraries and so on. These functions are called core functions and have its own header file, static libraries and DLLs.

Table 2-1

<table>
<thead>
<tr>
<th>Code</th>
<th>Header File</th>
<th>Static Libraries</th>
<th>DLL</th>
<th>Prefix in Function Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ippCore</td>
<td>ippcore.h</td>
<td>ippcorel.lib,</td>
<td>ippcore-<em>.</em>.dll</td>
<td>ipp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ippcore_t.lib</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

here *.* refers to the product version number, for example 6.1
Domains

For organizational purposes Intel IPP is internally divided into subdivisions of related functions. Each subdivision is called domain, (or functional domain) and generally has its own header file, static libraries, DLLs, and tests. These domains map easily to the types of input data and the corresponding prefixes. The Intel IPP Manual indicates in which header file each function can be found. The table below lists each domain’s code, header and library names, and functional area.

<table>
<thead>
<tr>
<th>Code</th>
<th>Header file</th>
<th>Static Libraries</th>
<th>DLL</th>
<th>Prefix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ippAC</td>
<td>ippac.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ipps</td>
<td>audio coding</td>
</tr>
<tr>
<td>ippCC</td>
<td>ippcc.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ippi</td>
<td>color conversion</td>
</tr>
<tr>
<td>ippCH</td>
<td>ippch.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ipps</td>
<td>string operations</td>
</tr>
<tr>
<td>ippCP</td>
<td>ippcp.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ipps</td>
<td>cryptography</td>
</tr>
<tr>
<td>ippCV</td>
<td>ippcv.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ippi</td>
<td>computer vision</td>
</tr>
<tr>
<td>ippDC</td>
<td>ippdc.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ipps</td>
<td>data compression</td>
</tr>
<tr>
<td>ippDI</td>
<td>ippdi.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ipps</td>
<td>data integrity</td>
</tr>
<tr>
<td>ippGEN</td>
<td>ippg.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ippg</td>
<td>generated functions</td>
</tr>
<tr>
<td>ippIP</td>
<td>ippi.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ippi</td>
<td>image processing</td>
</tr>
<tr>
<td>ippJP</td>
<td>ippj.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ippi</td>
<td>image compression</td>
</tr>
<tr>
<td>ippMX</td>
<td>ippm.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ippm</td>
<td>small matrix operations</td>
</tr>
<tr>
<td>ippRR</td>
<td>ippr.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ippr</td>
<td>realistic rendering and 3D data processing</td>
</tr>
<tr>
<td>ippSC</td>
<td>ippsc.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ipps</td>
<td>speech coding</td>
</tr>
<tr>
<td>ippSP</td>
<td>ippsp.h</td>
<td>ippac*.lib</td>
<td>ippac**.dll</td>
<td>ipps</td>
<td>signal processing</td>
</tr>
</tbody>
</table>
Function Naming and Parameters

Function names in Intel IPP are structured in order to simplify their identification and use. Understanding Intel IPP naming conventions can save you a lot of time and effort in figuring out what the purpose of a specific function is and in many cases you can derive this basic information straight from the function’s self-explanatory name.

Naming conventions for the Intel IPP functions are similar for all covered domains.

Intel IPP function names include a number of fields that indicate the data domain, operation, data type, and execution mode. Each field can only span over a fixed number of pre-defined values.

Function names have the following general format:

```
ipp<data-domain><name>[<_datatype>][<_descriptor>](<parameters>));
```

The elements of this format are explained in the sections that follow.

Data-Domain

The **data-domain** is a single character indicating type of the input data. The current version of Intel IPP supports the following data-domains:

- `s` for signals (expected data type is a 1D array)
- `g` for signals of the fixed length (expected data type is a 1D array)
- `i` for images and video (expected data type is a 2D array of pixels)
- `m` for vectors and matrices (expected data type is a matrix or vector)
- `r` for realistic rendering functionality and 3D data processing (expected data type depends on supported rendering techniques)
The core functions in Intel IPP do not operate on one of these types of the input data (see Core Functions). These functions have ipp as a prefix without data-domain field, for example, ippGetStatusString.

**Name**

The *name* identifies the algorithm or operation that the function does. It has the following format:

\[
\text{name} = \text{operation}[\_\text{modifier}]
\]

The *operation* field is one or more words, acronyms, and abbreviations that identify the base operation, for example Set, Copy. If the operation consists of several parts, each part starts with an uppercase character without underscore, for example, HilbertInitAlloc.

The *modifier*, if present, denotes a slight modification or variation of the given function. For example, the modifier CToC in the function ippsFFTInv_CToC_32fc signifies that the inverse fast Fourier transform operates on complex data, performing complex-to-complex (CToC) transform. Functions for matrix operation have and object type description as a modifier, for example, ippmMul_mv - multiplication of a matrix by a vector.

**Data Types**

The *datatype* field indicates data types used by the function in the following format:

\[
\text{datatype} = \text{bit_depth}\text{bit_interpretation},
\]

where

\[
\text{bit_depth} = <1|8|16|32|64>
\]

and

\[
\text{bit_interpretation} = <u|s|f>[c].
\]

Here *u* indicates "unsigned integer", *s* indicates "signed integer", *f* indicates "floating point", and *c* indicates "complex".

For functions that operate on a single data type, the *datatype* field contains only one value.

If a function operates on source and destination objects that have different data types, the respective data type identifiers are listed in the function name in order of source and destination as follows:

\[
\text{datatype} = \text{src1Datatype}[\text{src2Datatype}][\text{dstDatatype}].
\]

For example, the function ippsDotProd_16s16sc computes the dot product of 16-bit short and 16-bit complex short source vectors and stores the result in a 16-bit complex short destination vector. The *dstDatatype* modifier is not present in the name because the second operand and the result are of the same type.
Descriptor

The optional descriptor field describes the data associated with the operation. It can contain implied parameters and/or indicate additional required parameters.

To minimize the number of code branches in the function and thus reduce potentially unnecessary execution overhead, most of the general functions are split into separate primitive functions, with some of their parameters entering the primitive function name as descriptors.

However, where the number of permutations of the function becomes large and unreasonable, some functions may still have parameters that determine internal operation (for example, ippiThreshold).

The following descriptors are used in Intel IPP:

A  Image data contains an alpha channel as the last channel, requires C4, alpha channel is not processed.
A0 Image data contains an alpha channel as the first channel, requires C4, alpha channel is not processed.
Axx Specifies the bits of accuracy of the result for advanced arithmetic operations.
C  The function operates on a specified channel of interest (COI) for each source image.
Cn Image data is made of n discrete interleaved channels (n= 1, 2, 3, 4).
Dx Signal is x-dimensional (default is D1).
I  The operation is performed in-place (default is not-in-place).
L  Layout description of the objects for matrix operation, or indicates that one pointer is used for each row in D2 array for signal processing.
M  The operation uses a mask to determine pixels to be processed.
P  Pointer description of the objects for matrix operation, or specified number of vectors to be processed for signal processing.
Pn Image data is made of n discrete planar (non-interleaved) channels (n= 1, 2, 3, 4) with separate pointer to each plane.
R  The function operates on a defined region of interest (ROI) for each source image.
S  Standard description of the objects for matrix operation.
Sfs Saturation and fixed scaling mode (default is saturation and no scaling).
s  Saturation and no scaling.

The descriptors in function names are always presented in alphabetical order.
Some data descriptors are implied when dealing with certain operations. For example, the default for image processing functions is to operate on a two-dimensional image and to saturate the results without scaling them. In these cases, the implied abbreviations D2 (two-dimensional signal) and s (saturation and no scaling) are not included in the function name.

**Parameters**

The *parameters* field specifies the function parameters (arguments).

The order of parameters is as follows:

1. All source operands. Constants follow arrays
2. All destination operands. Constants follow arrays
3. Other, operation-specific parameters

The parameters name has the following conventions.

- Arguments defined as pointers start with *p*, for example, *pPhase*, *pSrc*, *pSeed*;
- arguments defined as double pointers start with *pp*, for example, *ppState*; and
- arguments defined as values start with a lowercase letter, for example, *val*, *src*, *srcLen*.

Each new part of an argument name starts with an uppercase character, without underscore, for example, *pSrc*, *lenSrc*, *pDlyLine*.

Each argument name specifies its functionality. Source arguments are named *pSrc* or *src*, sometimes followed by names or numbers, for example, *pSrc2*, *srcLen*. Output arguments are named *pDst* or *dst* followed by names or numbers, for example, *pDst1*, *dstLen*. For in-place operations, the input/output argument contains the name *pSrcDst*.

Examples of function syntax:

- \( \text{ippsIIR	extunderscore}32f\_\text{I}(\text{Ipp32f}^* \ pSrcDst, \text{int} \ len, \text{IppsIIRState	extunderscore}32f^* \ pState); \)
- \( \text{ippiConvert	extunderscore}8u1u\_\text{C1R}(\text{const} \ \text{Ipp8u}^* \ pSrc, \text{int} \ srcStep, \text{Ipp8u}^* \ pDst, \text{int} \ dstStep, \text{int} \ dstBitOffset, \text{IppSize} \ roiSize, \text{Ipp8u} \ threshold); \)
- \( \text{ippiSub	extunderscore}vac\_32f(\text{const} \ \text{Ipp32f}^* \ pSrc, \text{int} \ srcStride0, \text{int} \ srcStride2, \text{Ipp32f} \ val, \text{Ipp32f}^* \ pDst, \text{int} \ dstStride0, \text{int} \ dstStride2, \text{int} \ len, \text{int} \ count). \)

**Checking Your Installation**

Once you complete the installation of Intel IPP, it is useful to follow these steps that confirm proper installation and configuration of the library.
1. Check that the directory you chose for installation has been created: `<installation path>\Intel\IPP\6.1.x.xxx\ia32`. The default installation directory is `C:\Program Files\Intel\IPP\6.1.x.xxx\ia32`.

2. Check that file `ippenv.bat` is placed in the `\tools\env` directory. You can use this file to set the environment variables `PATH`, `LIB`, and `INCLUDE` in the user shell.

3. Check that the dispatching and processor-specific libraries are on the path.

4. Run `ippiDemo.exe` (or `ippsDemo.exe`) from the `C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\demo`.

   If you receive the error messages "This application has failed to start because ippcore.dll was not found” or "No DLL were found in the waterfall procedure”, this means that the operating system is unable to determine the location of the Intel IPP dynamic libraries. To solve this issue:
   - Ensure that the Intel IPP directory is in the path. Before using the Intel IPP dynamic libraries, add `C:\Program Files\Intel\IPP\6.1.x.xxx\ia32` to the `PATH` environment variable as described in Setting Environment Variables;
   - Manually copy the contents of `IPP\6.1.x.xxx\ia32\bin` to the `\system32` directory;
   - Copy the contents of `IPP\6.1.x.xxx\ia32\bin` to the application directory.

Note that you need to delete all Intel IPP DLLs from previous releases from the `C:\winnt\system` and `C:\winnt\system32` directories. Verify that paths to older library versions are not listed in the `PATH` environment variable.

### Obtaining Version Information

To obtain information about the active library version including the version number, package ID, and the licensing information, call the `ippGetLibVersion` function. See the “Support Functions” chapter in the “Intel IPP Reference Manual” (v.1) for the function description and calling syntax.

You may also get the version information in the `ippversion.h` file located in the `\include` directory.

### Building Your Application

Follow the procedures described below to build the application.

### Setting Environment Variables

The batch file `ippenv.bat` in the `\tools\env` directory sets the Intel IPP `LIB`, `INCLUDE`, and `PATH` environment variables for a command prompt session.
To set the environment variables outside of a single command prompt session, complete the following steps, for example in the Windows XP* OS:

1. Right-click the **My Computer** icon on your desktop or from the Windows Explorer* and select **Properties** (or open **Control Panel** and select **System**),

2. Select the **Advanced** tab,

3. Select the **Environment Variables** button,

4. Use the interface to set the environment variables for only the current user (top dialog box) or for anyone who uses the system (bottom dialog box),

5. Select the variable you wish to modify and click the **Edit** button,

6. Add the path to the related Intel IPP files to the existing list. For example:
   
   Select **LIB** and type in the directory for the Intel IPP stub libraries (default is: `C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\stublib`),
   
   Select **INCLUDE** and type in the directory for the Intel IPP header files (default is: `C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\include`),
   
   Select **PATH** and type in the directory for the Intel IPP binaries (default is: `C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\bin`).

7. Click **OK** in the **Edit User Variable** dialog box,

8. Click **OK** in the **Environment Variables** dialog box,

9. Click **OK** in the **Systems Properties** dialog box.

For information on how to set up environment variables for threading, refer to **Supporting Multithreaded Applications**.

### Including Header Files

Intel IPP functions and types are defined in several header files that are organized by the function domains and located in the `\include` directory. For example, the `ippac.h` file contains declarations for all audio coding and processing functions.

The file `ipp.h` includes all Intel IPP header files. For forward compatibility, include only `ipp.h` in your program.

### Calling IPP Functions

Due to the DLL dispatcher and merged static library mechanisms described in **Linking Your Application with Intel® IPP**, calling Intel IPP functions is as simple as calling any other C function.

To call an Intel IPP function, do the following:
1. Include the ipp.h header file
2. Set up the function parameters
3. Call the function

The multiple versions of optimized code for each function are concealed under a single entry point. Refer to the "Intel IPP Reference Manual" for function descriptions, lists of required parameters, return values and so on.
Before You Begin Using Intel IPP

Before you start using Intel IPP, it is helpful to understand some basic concepts. Table 2-3 summarizes important things to consider before you start using Intel IPP.

<table>
<thead>
<tr>
<th>Function domains</th>
<th>Identify the Intel IPP function domain that meets your needs.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reason</strong></td>
<td>If you know function domain you intend to use will narrow the search in the Reference Manuals for specific routines you need.</td>
</tr>
<tr>
<td></td>
<td>Besides, you may easily find a sample you would like to run from <a href="http://www.intel.com/software/products/ipp/samples.htm">http://www.intel.com/software/products/ipp/samples.htm</a>.</td>
</tr>
<tr>
<td></td>
<td>Refer to <a href="#">Table 5-9</a> to understand what function domains are and what libraries are needed, and to <a href="#">Table 5-10</a> to understand what kind of cross-domain dependency is introduced.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Linking method</th>
<th>Decide what linking method is appropriate for linking.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reason</strong></td>
<td>If you choose a linking method that suits, you will get the best linking results. For information on the benefits of each linking method, linking command syntax and examples, as well as on other linking topics, such as how to create a custom dynamic library, see <a href="#">Linking Your Application with Intel® IPP</a>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Threading model</th>
<th>Select among the following options to determine how you are going to thread your application:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Your application is already threaded.</td>
</tr>
<tr>
<td></td>
<td>• You may want to use the Intel® threading capability, that is, Compatibility OpenMP* run-time library (libiomp), or a threading capability provided by a third-party compiler.</td>
</tr>
<tr>
<td></td>
<td>• You do not want to thread your application.</td>
</tr>
<tr>
<td><strong>Reason</strong></td>
<td>By default, Intel IPP uses the OpenMP* software to set the number of threads that will be used. If you need a different number, you have to set it yourself using one of the available mechanisms. For more information, see <a href="#">Supporting Multithreaded Applications</a>.</td>
</tr>
</tbody>
</table>
This chapter discusses the structure of Intel IPP after installation as well as the library types supplied.

**High-level Directory Structure**

Table 3-1 shows the high-level directory structure of Intel IPP after installation.

<table>
<thead>
<tr>
<th>Directory</th>
<th>File types</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ipp directory&gt;</code></td>
<td>Main directory (by default: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32)</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\ippEULA.rtf</code></td>
<td>End User License Agreement for Intel IPP</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\bin</code></td>
<td>Intel IPP dynamic link libraries (DLLs)</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\demo</code></td>
<td>Executable programs that demonstrate various image and signal processing functionalities</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\doc</code></td>
<td>Intel IPP documentation files</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\include</code></td>
<td>Intel IPP header files</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\lib</code></td>
<td>Intel IPP static libraries</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\samples</code></td>
<td>Intel IPP application-level samples (see &quot;Using Intel IPP Samples&quot;)</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\stublib</code></td>
<td>Intel IPP import libraries, used for linking DLLs.</td>
</tr>
<tr>
<td><code>&lt;ipp directory&gt;\tools</code></td>
<td>Intel IPP Performance Test tool, linkage tools, and tool to set environment variables</td>
</tr>
</tbody>
</table>
Table 3-2 lists the types of libraries in Intel IPP and shows examples of the library files supplied:

<table>
<thead>
<tr>
<th>Library types</th>
<th>Description</th>
<th>Folder location</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic</td>
<td>Dynamic link libraries (DLLs) include both processor dispatchers and function implementations</td>
<td>\ia32\bin</td>
<td>ipps-6.1.dll, ippst7-6.1.dll</td>
</tr>
<tr>
<td>Static (import)</td>
<td>&quot;Stub&quot; static library files. They load the required DLLs and link to the correct entry points</td>
<td>\ia32\stublib</td>
<td>ipps.lib</td>
</tr>
<tr>
<td>Static merged</td>
<td>Contain function implementations for all supported processor types</td>
<td>\ia32\lib</td>
<td>ippsmerged.lib</td>
</tr>
<tr>
<td>Threaded static merged</td>
<td>Contain threaded function implementations</td>
<td>\ia32\lib</td>
<td>ippsmerged_t.lib</td>
</tr>
<tr>
<td>Static emerged</td>
<td>Contain dispatchers for the merged libraries</td>
<td>\ia32\lib</td>
<td>ippsemerged.lib</td>
</tr>
</tbody>
</table>

Using Intel IPP Dynamic Link Libraries (DLLs)

Intel IPP comes with the dynamic link libraries (DLLs) in the \ia32\bin directory.

To load the Intel IPP DLLs and link to the correct entry points, use "stub" library files in the \ia32\stublib directory that come with the Intel IPP package (see Table 3-1).

To use the DLLs, link to the ipp*.lib files. You must set your lib environment variable using the ippenv.bat file or refer to these files using their full path. Including these libraries is all you need to do to dynamically link to the DLL for the appropriate processor.

The DLLs ipp*-6.1.dll (* denotes the appropriate function domain) are "dispatcher" dynamic libraries. At run time, they detect the processor and load the correct processor-specific DLLs. This allows you to write code to call the Intel IPP functions without worrying about which processor the code will execute on - the appropriate version is
automatically used. These processor-specific libraries are named ipp*px-6.1.dll, ipp*w7-6.1.dll, ipp*t7-6.1.dll, ipp*v8-6.1.dll, and ipp*p8-6.1.dll (see Table 5-4). For example, in the \ia32\bin directory, ippiv8-6.1.dll reflects the imaging processing libraries optimized for the Intel® Core™ 2 Duo processors.

The only actions needed to use the Intel IPP DLLs, once the "stub" static libraries are linked, is to ensure that the dispatching DLLs and the processor-specific DLLs are on the path.

See also Selecting the Intel IPP Libraries Needed by Your Application.

NOTE. You must include the appropriate libiomp5md.dll in your PATH environment variable. Include the directory bin when running on a system with IA-32 architecture.

The following shows a simple example of calling an IPP function; it uses the code in file t1.cpp:

Example 3-1 Code calling example

```c
#include <stdio.h>
#include <ipp.h>

int main() {
    const IppLibraryVersion* libver = ippGetLibVersion();
    printf("%s %s\n", libver->Name, libver->Version);
    return 0;
}
```

```
cmdlinetest>cl /nologo /Fet1.exe -I "C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\include" t1.cpp "C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\stublib\ippcore.lib"
t1.cpp
cmdlinetest>t1.exe
ippcore-6.1.dll 6.1 build 81
```

Using Intel IPP Static Libraries

The Intel IPP comes with "merged" static library files that contain every processor version of each function. These files reside in the \ia32\lib directory (see Table 3-1).
Just as with the dynamic dispatcher, the appropriate version of a function is executed when the function is called. This mechanism is not as convenient as the dynamic mechanism, but it can result in a smaller total code size in spite of the big size of the static libraries.

To use these static libraries, link to the appropriate files ipp*merged.lib in the \lib directory. You will either need to set your LIB environment variable using the ippenv.bat file or refer to these files using their full path.

See also Selecting the Intel IPP Libraries Needed by Your Application.

### Contents of the Documentation Directory

Table 3-3 shows the content of the \doc subdirectory in the Intel IPP installation directory.

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ipp_documentation.htm</td>
<td>Documentation index. Lists the principal Intel IPP documents with appropriate links to the documents</td>
<td></td>
</tr>
<tr>
<td>ReleaseNotes.pdf</td>
<td>General overview of the product and information about this release. These files can be viewed prior to the product installation</td>
<td></td>
</tr>
<tr>
<td>README.txt</td>
<td>Initial User Information</td>
<td></td>
</tr>
<tr>
<td>INSTALL.htm</td>
<td>Installation guide</td>
<td></td>
</tr>
<tr>
<td>ThreadedFunctionsList.txt</td>
<td>List of all Intel IPP functions threaded with OpenMP*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel IPP Reference Manual (in four volumes):</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Signal Processing</strong> (vol.1) - contains detailed descriptions of Intel IPP functions and interfaces for signal processing, audio coding, speech recognition and coding, data compression and integrity, string operations and vector arithmetic.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Image and Video Processing</strong> (vol.2) - contains detailed descriptions of Intel IPP functions and interfaces for image processing and compression, color and format conversion, computer vision, video coding.</td>
<td></td>
</tr>
</tbody>
</table>

---

3 Intel® IPP User’s Guide
## Table 3-3 Contents of the `\doc` Directory

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ippmman.pdf,</td>
<td><em>Small Matrices, Realistic Rendering</em> (vol.3)</td>
<td>- contains detailed descriptions of Intel IPP functions and interfaces for vector and matrix algebra, linear system solution, least squares and eigenvalue problems as well as for realistic rendering and 3D data processing.</td>
</tr>
<tr>
<td>ippmman.chm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ippcpman.pdf,</td>
<td><em>Cryptography</em> (vol.4) - contains detailed descriptions of Intel IPP functions and interfaces for cryptography.</td>
<td></td>
</tr>
<tr>
<td>ippcpman.chm</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Configuring Your Development Environment

This chapter explains how to configure your development environment for the use with Intel® IPP.

Configuring Microsoft* Visual C++* .NET 2003 or Microsoft Visual C++*2005 Software to Link with Intel IPP

To configure Microsoft* Visual C++* .NET 2003 or Microsoft* Visual C++* 2005 environments to link with Intel IPP, follow the steps below:

1. Select View > Solution Explorer (make sure this window is active).
2. Select Tools > Options > Projects and Solutions > VC++ Directories.
3. In the drop down menu Show directories for:, select Include Files, and type in the directory for the Intel IPP include files (for example, the default is: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\include).
4. In the drop down menu titled Show directories for:, select Library Files, and then type in the directory for the Intel IPP library files (for example, the default is: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\stublib or C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\lib).
5. In the drop down menu Show directories for:, select Executable Files and type in the directory for the Intel IPP executable files (for example, the default is: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\bin).
6. On the main toolbar, select Project > Properties > Linker > Input. In the Additional Dependencies line, add the libraries you wish to link to (for example, ipps.lib or ippmerged.lib). For more information on choosing the best linking method for your Intel IPP application, please refer to Linking Your Application with Intel® IPP.
Creating Visual C++ 2005 Project Files for the Intel® IPP Samples

To create Microsoft* Visual* C++ 2005 project files for the Intel IPP samples, follow the steps below which use jpegview sample code as an example.

2. Select File > New > Project from Existing Code:
3. Select Visual C++ as the type of project you would like to create from the dropdown menu in the popup window. Fill in the project file location and project name. Check the Add files to the project from these folders check box. Click Add, select the jpegview folder, and click OK.
4. Select View > Solution Explorer (make sure this window is active).
5. Select Projects > Properties.
6. Under Configuration Properties > C/C++ in the drop down menu titled Show directories for:, select Include Files and type in the directory for the Intel IPP include files (for example, default: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\include).
7. In the drop down menu titled Show directories for:, select Library Files and type in the directory for the Intel IPP library files (for example, default: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\stublib or C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\lib).
8. In the drop down menu titled Show directories for:, select Executable Files and type in the directory for the Intel IPP executable files (for example, default: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\bin).

Building a Microsoft* Visual C++ .NET* Solution for the UMC Sample Code

To generate the Microsoft* Visual C++ .NET* project and solution files for the Intel IPP UMC sample code, use the script file gen_vsproj.pl, which can be downloaded from http://www.intel.com/support/performancetools/libraries/ipp/win/ia/sb/cs-022835.htm. It works under Microsoft Windows* OS with the ActivePerl* script installed. This script can build solution files for Intel® C++ Compiler 10.0, Microsoft* Visual C++ .NET* 2005. Here are some notes for using this script:
1. Put the script file in the Intel IPP UMC sample code folder: \ipp-samples\audio-video-codecs.

2. At the command line, use the `gen_vsproj.pl` command to create solution files. Typing "gen_vsproj.pl" will print all command messages. Here is an example that generates Microsoft Visual C++.NET 2003 solutions for applications with the IA-32 architecture:

```
>gen_vsproj.pl -vs2003 -noicl -con application\* -gui application\umc_reverb_demo -dll plug-in\audio_codecs -lib codec\* core\* io\* pipeline\* plug-in\object_factory -I"javascript:void(null);" -win32 -L "javascript:void(null);" -l "javascript:void(null);" ddraw.lib dsound.lib
```

Solution files are located in the ipp-samples\audio-video-codecs\application\xxxx directories.

For details on running Intel IPP sample code, see Appendix, "Intel® IPP Samples".

### Using the IntelliSense* Capability

*IntelliSense* is a set of native features of the Microsoft Visual Studio* IDE that make language references easily accessible.

The user programming with Intel IPP in the Visual Studio Code Editor can employ two *IntelliSense* features: *Complete Word* and *Parameter Info*.

---

**NOTE.** Both features use header files. Therefore, to benefit from *IntelliSense*, make sure the path to the include files is specified in the Visual Studio or solution settings. See above sections on how to do this.

---

**Complete Word**

For a software library, the *Complete Word* feature types or prompts for the rest of the name defined in the header file once the first few characters of the name are typed in your code.

Provided your C/C++ code contains the `include` statement with the appropriate Intel IPP header file, to complete the name of the function or named constant specified in the header file, follow these steps:
1. Type the first few characters of the name (for example, ippsFFT)
2. Press **Alt+RIGHT ARROW** or **Ctrl+SPACEBAR**.
   If you have typed enough characters to eliminate ambiguity in the name, the rest of
   the name is typed automatically. Otherwise, the pop-up list of the names specified in
   the header file opens (see **Figure 4-1**).
3. Select the name from the list, if needed.

**Figure 4-1**  **IntelliSense Complete Word**

---

**Parameter Info**

The **Parameter Info** feature displays the parameter list for a function to give information on
the number and types of parameters.
Provided your C/C++ code contains the `#include` statement with the appropriate Intel IPP header file, to get the list of parameters of a function specified in the header file, follow these steps:

1. Type the function name
2. Type the opening parenthesis

This makes the tooltip with the function API prototype pop up, and the current parameter in the API prototype is highlighted (see Figure 4-2).

**Figure 4-2  IntelliSense Parameter Info**
Using Intel® IPP with Intel® C++ Compiler

Using Intel IPP with the Intel C++ Compiler is similar as to using Intel IPP with the Microsoft* C++ Compiler.

In Microsoft Visual C++*.NET environment, instead of providing settings at Tools > Options > Projects > VC++ Directories, choose to provide settings at Tools > Options > Intel® C++ by following these steps:

1. Select View > Solution Explorer (and make sure this window is active),
2. Select Tools > Options > Projects > Tools > Options > Intel® C++ > Intel® C++ XX,
3. In the drop down menu Show directories for:, select Include Files and then type in the directory for the Intel IPP include files (for example, the default is: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\include),
4. In the Include path, type in the directory for the Intel IPP library files (for example, the default is: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\stublib or C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\lib),
5. In the library path, type in the directory for the Intel IPP executable files (for example, the default: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\bin),
6. On the main toolbar, select Project > Properties > Linker > Input and in the Additional Dependencies line, add the libraries you wish to link to (for example, ipps.lib or ippsmerged.lib).

Using Intel® IPP with Borland C++ Builder* Integrated Development Environment

You cannot directly link to the Intel IPP static library in Borland C++ Builder*. Instead, try the following:

- Use the Intel IPP merged static libraries to create a custom DLL (export the functions called in your application). The custom DLL and merged static library tools are available as part of the integration sample package. The Intel IPP static libraries are located in the IPP\6.1.x.xxx\ia32\lib directory.
- Use IMPLIB (on the DLL) to create an import library in the Borland environment.
This chapter discusses linking Intel IPP to an application, considers differences between the linking methods regarding development and target environments, installation specifications, run-time conditions, and other application requirements to help the user select the linking method that suits him best, shows linking procedure for each linking method, and gives linking examples.

Dispatching

Intel IPP uses codes optimized for various central processing units (CPUs). Dispatching refers to detection of your CPU and selecting the Intel IPP binary that corresponds to the hardware that you are using. For example, in the \ia32\bin directory, file ippiv8-6.1.dll reflects the optimized imaging processing libraries for Intel® Core™ 2 Duo processors.

A single Intel IPP function, for example ippCopy_8u(), may have many versions, each one optimized to run on a specific Intel® processor with specific architecture, for example: the version of this function optimized for the Pentium® 4 processor is w7_ippsCopy_8u(). Table 5-1 shows processor-specific codes used in Intel IPP.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>IA-32 Intel® architecture</td>
<td></td>
</tr>
<tr>
<td>px</td>
<td>C-optimized for all IA-32 processors</td>
</tr>
<tr>
<td>w7</td>
<td>Optimized for processors with Intel® Streaming SIMD Extensions 2 (Intel SSE2)</td>
</tr>
<tr>
<td>t7</td>
<td>Optimized for processors with Intel® Streaming SIMD Extensions 3 (Intel SSE3)</td>
</tr>
<tr>
<td>v8</td>
<td>Optimized for processors with Intel® Supplemental Streaming SIMD Extensions 3 (Intel SSSE3)</td>
</tr>
</tbody>
</table>
Processor Features

To obtain information about the features of the processor used in your computer system, use function ippGetCpuFeatures, which is declared in the ippcore.h file. This function retrieves main CPU features returned by the function CPUID.1 and stores them consecutively in the mask that is returned by the function. Table 5-2 lists all CPU features that can be retrieved (see more details in the description of the function ippGetCpuFeatures in the Intel IPP Reference Manual, vol.1).

<table>
<thead>
<tr>
<th>Mask Value</th>
<th>Processor Features</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ippCPUID_MMX</td>
<td>MMXTM technology</td>
</tr>
<tr>
<td>2</td>
<td>ippCPUID_SSE</td>
<td>Intel® Streaming SIMD Extensions</td>
</tr>
<tr>
<td>4</td>
<td>ippCPUID_SSE2</td>
<td>Intel® Streaming SIMD Extensions 2</td>
</tr>
<tr>
<td>8</td>
<td>ippCPUID_SSE3X</td>
<td>Intel® Streaming SIMD Extensions 3</td>
</tr>
<tr>
<td>16</td>
<td>ippCPUID_SSSE3</td>
<td>Supplemental Intel® Streaming SIMD Extensions</td>
</tr>
<tr>
<td>32</td>
<td>ippCPUID_MOVBE</td>
<td>MOVBE instruction is supported</td>
</tr>
<tr>
<td>64</td>
<td>ippCPUID_SSE41</td>
<td>Intel® Streaming SIMD Extensions 4.1</td>
</tr>
<tr>
<td>128</td>
<td>ippCPUID_SSE42</td>
<td>Intel® Streaming SIMD Extensions 4.2</td>
</tr>
<tr>
<td>256</td>
<td>ippCPUID_AVXX</td>
<td>Intel® Advanced Vector Extensions (Intel AVX) instruction set is supported</td>
</tr>
<tr>
<td>512</td>
<td>ippAVX_ENABLEDBYOS</td>
<td>The operating system supports Intel AVX</td>
</tr>
<tr>
<td>1024</td>
<td>ippCPUID_AES</td>
<td>AES instruction is supported</td>
</tr>
<tr>
<td>2048</td>
<td>ippCPUID_CLMUL</td>
<td>PCLMULQDQ instruction is supported</td>
</tr>
</tbody>
</table>
Processor Type

To detect the processor type used in your computer system, use function ippGetCpuType, which is declared in the ippcore.h file. It returns an appropriate IppCpuType variable value. All of the enumerated values are given in the ippdefs.h header file. For example, the return value ippCpuCoreDuo means that your system uses Intel® Core™ Duo processor.

Table 5-3 shows possible values of ippGetCpuType and their meaning.

Table 5-3  Detecting processor type. Returned values and their meaning

<table>
<thead>
<tr>
<th>Returned Variable Value</th>
<th>Processor Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ippCpuPP</td>
<td>Intel® Pentium® processor</td>
</tr>
<tr>
<td>ippCpuPMX</td>
<td>Pentium® processor with MMX™ technology</td>
</tr>
<tr>
<td>ippCpuPPR</td>
<td>Pentium® Pro processor</td>
</tr>
<tr>
<td>ippCpuPII</td>
<td>Pentium® II processor</td>
</tr>
<tr>
<td>ippCpuPIII</td>
<td>Pentium® III processor and Pentium® III Xeon® processor</td>
</tr>
<tr>
<td>ippCpuP4</td>
<td>Pentium® 4 processor and Intel® Xeon® processor</td>
</tr>
<tr>
<td>ippCpuP4HT</td>
<td>Pentium® 4 processor with Hyper-Threading Technology</td>
</tr>
<tr>
<td>ippCpuP4HT2</td>
<td>Pentium® Processor with Intel® Streaming SIMD Extensions 3</td>
</tr>
<tr>
<td>ippCpuCentrino</td>
<td>Intel® Centrino™ mobile Technology</td>
</tr>
<tr>
<td>ippCpuCoreSolo</td>
<td>Intel® Core™ Solo processor</td>
</tr>
<tr>
<td>ippCpuCoreDuo</td>
<td>Intel® Core™ Duo processor</td>
</tr>
<tr>
<td>ippCpuITP</td>
<td>Intel® Itanium® processor</td>
</tr>
<tr>
<td>ippCpuITP2</td>
<td>Intel® Itanium® 2 processor</td>
</tr>
<tr>
<td>ippCpuEM64T</td>
<td>Intel® 64 Instruction Set Architecture (ISA)</td>
</tr>
<tr>
<td>ippCpuC2D</td>
<td>Intel® Core™ 2 Duo Processor</td>
</tr>
<tr>
<td>ippCpuC2Q</td>
<td>Intel® Core™ 2 Quad processor</td>
</tr>
<tr>
<td>ippCpuPenryn</td>
<td>Intel® Core™ 2 processor with Intel® Streaming SIMD Extensions 4.1 instruction set</td>
</tr>
<tr>
<td>ippCpuBonnell</td>
<td>Intel® Atom™ processor</td>
</tr>
<tr>
<td>ippCpuNehalem</td>
<td>Intel® Core™ i7 processor</td>
</tr>
<tr>
<td>ippCpuSSE</td>
<td>Processor with Intel® Streaming SIMD Extensions instruction set</td>
</tr>
<tr>
<td>ippCpuSSE2</td>
<td>Processor with Intel® Streaming SIMD Extensions 2 instruction set</td>
</tr>
</tbody>
</table>
Selecting Between Linking Methods

You can use different linking methods for Intel IPP:

- Dynamic linking using the run-time dynamic link libraries (DLLs)
- Static linking with dispatching using emerged and merged static libraries
- Static linking without automatic dispatching using merged static libraries
- Dynamic linking with your own - custom - DLL.

Answering the following questions helps you select the linking method which best suites you:

- Are there limitations on how large the application executable can be? Are there limitations on how large the application installation package can be?
- Is the Intel IPP-based application a device driver or similar “ring 0” software that executes in the kernel mode at least some of the time?
- Will various users install the application on a range of processor types, or is the application explicitly supported only on a single type of processor? Is the application part of an embedded computer where only one type of processor is used?
- What resources are available for maintaining and updating customized Intel IPP components? What level of effort is acceptable for incorporating new processor optimizations into the application?
Dynamic Linking

The dynamic linking is the simplest method and the most commonly used. It takes full advantage of the dynamic dispatching mechanism in the dynamic link libraries (DLLs) (see also Intel® IPP Structure). The following table summarizes the features of dynamic linking to help you understand trade-offs of this linking method.

<table>
<thead>
<tr>
<th>Benefits</th>
<th>Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Automatic run-time dispatch of processor-specific optimizations</td>
<td>• Application executable requires access to Intel IPP run-time dynamic link libraries (DLLs) to run</td>
</tr>
<tr>
<td>• Enabling updates with new processor optimizations without recompile/relink</td>
<td>• Not appropriate for kernel-mode/device-driver/ring-0 code</td>
</tr>
<tr>
<td>• Reduction of disk space requirements for applications with multiple Intel IPP-based executables</td>
<td>• Not appropriate for web applets/plug-ins that require very small download</td>
</tr>
<tr>
<td>• Enabling more efficient shared use of memory at run-time for multiple Intel IPP-based applications</td>
<td>• There is a one-time performance penalty when the Intel IPP DLLs are first loaded</td>
</tr>
</tbody>
</table>

To dynamically link with Intel IPP, follow these steps:

1. Add ipp.h, which includes the header files of all IPP domains.
2. Use the normal IPP function names when calling IPP functions.
3. Link corresponding domain import libraries. For example, if you use the ippsCopy_8u function, link against ipps.lib.
4. Make sure that run-time libraries, for example ipps.dll, are on the executable search path at run time. Run the ippenv.bat from directory \tools\env to ensure this application built with the Intel IPP dynamic link libraries loads the appropriate processor-specific library.

Static Linking (with Dispatching)

Some applications use only a few Intel® IPP functions and require a small memory footprint. Using the static link libraries via the emerged and merged libraries offers both the benefits of a small footprint and optimization on multiple processors. The emerged
libraries (such as ippsemerged.lib) provide an entry point for the non-decorated (with normal names) IPP functions, and the jump table to each processor-specific implementation. When linked with your application, the function calls corresponding functions in the merged libraries (such as ippsemerged.lib) in accordance with the CPU setting detected by functions in ippcorel.lib. The emerged libraries do not contain any implementation code.

The emerged libraries must be initialized before any non-decorated functions can be called. One may choose the function ippStaticInit() that initializes the library to use the best optimization available, or the function ippStaticInitCpu() that lets you specify the CPU. In any case, one of these functions must be called before any other IPP functions. Otherwise, a "px" version of the IPP functions will be called, which can decrease the performance of your application. Example 5-1 illustrates the performance difference. This example appears in the t2.cpp file:

**Example 5-1  Performance difference with and without calling StaticInit**

```c
#include <stdio.h>
#include <ipp.h>

int main() {
    const int N = 20000, loops = 100;
    Ipp32f src[N], dst[N];
    unsigned int seed = 12345678, i;
    Ipp64s t1,t2;
    // no StaticInit call, means PX code, not optimized
    ippsRandUniform_Direct_32f(src,N,0.0,1.0,&seed);
    t1=ippGetCpuClocks();
    for(i=0; i<loops; i++)
        ippsSqrt_32f(src,dst,N);
    t2=ippGetCpuClocks();
    printf("without StaticInit: %.1f clocks/element\n",
           (float)(t2-t1)/loops/N);
    ippStaticInit();
    t1=ippGetCpuClocks();
    for(i=0; i<loops; i++)
        ippsSqrt_32f(src,dst,N);
    t2=ippGetCpuClocks();
    printf("with StaticInit: %.1f clocks/element\n",
           (float)(t2-t1)/loops/N);
    return 0;
}
```

t2.cpp

cmdlinetest>t2
without StaticInit: 61.3 clocks/element
with StaticInit: 4.5 clocks/element
When you perform static linking via the emerged libraries, there are things you should consider. **Table 5-5** summarizes the pros and cons of this type of static linking.

**Table 5-5 Summary of Features of the Static Linking (with Dispatching)**

<table>
<thead>
<tr>
<th>Benefits</th>
<th>Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Dispatches processor-specific optimizations during run-time</td>
<td>• Intel IPP code is duplicated for multiple Intel IPP-based applications because of static linking</td>
</tr>
<tr>
<td>• Creates a self-contained application executable</td>
<td>• An additional function call for dispatcher initialization is needed (once) during program initialization</td>
</tr>
<tr>
<td>• Generates a smaller footprint than the full set of Intel IPP DLLs</td>
<td></td>
</tr>
</tbody>
</table>

Follow these steps to use static linking with dispatching:

1. Include ipp.h in your code.
2. Before calling any Intel IPP functions, initialize the static dispatcher using either the function ippStaticInit() or ippInitCpu(), which are declared in the header file ippcore.h.
3. Use the normal IPP function names to call IPP functions.
4. Link corresponding emerged libraries followed by merged libraries, and then ippcorel.lib. For example, if the function ippsCopy_8u() is used, the linked libraries are ippsemerged.lib, ippsmerged.lib, and ippcorel.lib.

**Static Linking (without Dispatching)**

This method uses linking directly with the merged static libraries. You may want to use your own static dispatcher instead of the provided emerged dispatcher. The IPP sample mergelib demonstrates how to do this.

Please refer to the latest updated sample from the Intel IPP samples directory: \ipp-samples\advanced-usage\linkage\mergelib at http://www.intel.com/software/products/ipp/samples.htm.

When a self-contained application is needed, only one processor type is supported and there are tight constraints on the executable size. One common use for embedded applications is when the application is bundled with only one type of processor.
Table 5-6 summarizes basic features of this method of linking.

### Table 5-6 Summary of Features of the Static Linking (without dispatching)

<table>
<thead>
<tr>
<th>Benefits</th>
<th>Considerations</th>
</tr>
</thead>
</table>
| • Small executable size with support for only one processor type  
• An executable suitable for kernel-mode/device-driver/ring-0 use*)  
• An executable suitable for a Web applet or a plug-in requiring very small file download and support for only one processor type  
• Self-contained application executable that does not require the Intel IPP run-time DLLs to run  
• Smallest footprint for application package  
• Smallest installation package | • The executable is optimized for only one processor type  
• Updates to processor-specific optimizations require rebuild and/or relink |

*) for not-threaded libraries only

You can use alternatives to the above procedure. The Intel IPP package includes a set of processor-specific header files (such as ipp_w7.h). You can use these header files instead of the IPPCALL macro. Refer to Static linking to Intel® IPP Functions for One Processor in \ia32\tools\staticlib\readme.htm.
Building a Custom DLL

Some applications have few internal modules and the Intel IPP code needs to be shared by these modules only. In this case, you can use dynamic linking with the customized dynamic link library (DLL) containing only those Intel IPP functions that the application uses. Table 5-7 summarizes features of the custom DLLs.

Table 5-7 Custom DLL Features

<table>
<thead>
<tr>
<th>Benefits</th>
<th>Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Run-time dispatching of processor-specific optimizations</td>
<td>• Application executable requires access to the Intel compiler specific run-time libraries that are delivered with Intel IPP.</td>
</tr>
<tr>
<td>• Reduced hard-drive footprint compared with a full set of Intel IPP DLLs</td>
<td>• Developer resources are needed to create and maintain the custom DLLs</td>
</tr>
<tr>
<td>• Smallest installation package to accommodate use of some of the same Intel IPP functions by multiple applications</td>
<td>• Integration of new processor-specific optimizations requires rebuilding the custom DLLs</td>
</tr>
<tr>
<td></td>
<td>• Not appropriate for kernel-mode/device-driver/ring-0 code</td>
</tr>
</tbody>
</table>

To create a custom DLL, you need to create a separate build step or project that generates the DLL and stubs. The specially developed sample demonstrates how it can be done. Please refer to the latest updated custom dll sample from the Intel IPP samples directory: \ipp-samples\advanced-usage\linkage\customdll at http://www.intel.com/software/products/ipp/samples.htm.
Comparison of Intel IPP Linkage Methods

Table 5-8 gives a quick comparison of the IPP linkage methods.

### Table 5-8  Intel IPP Linkage Method Summary Comparison

<table>
<thead>
<tr>
<th>Feature</th>
<th>Dynamic Linkage</th>
<th>Static Linkage with Dispatching</th>
<th>Static Linkage without Dispatching</th>
<th>Using Custom DLL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Updates</td>
<td>Automatic</td>
<td>Recompile &amp; redistribute</td>
<td>Release new processor-specific application</td>
<td>Recompile &amp; redistribute</td>
</tr>
<tr>
<td>Optimization</td>
<td>All processors</td>
<td>All processors</td>
<td>One processor</td>
<td>All processors</td>
</tr>
<tr>
<td>Build</td>
<td>Link to stub static libraries</td>
<td>Link to static libraries and static dispatchers</td>
<td>Link to merged libraries or threaded merged libraries</td>
<td>Build separate DLL</td>
</tr>
<tr>
<td>Calling</td>
<td>Regular names</td>
<td>Regular names</td>
<td>Processor-specific names</td>
<td>Regular names</td>
</tr>
<tr>
<td>Total Binary Size</td>
<td>Large</td>
<td>Small</td>
<td>Smallest</td>
<td>Small</td>
</tr>
<tr>
<td>Executable Size</td>
<td>Smallest</td>
<td>Small</td>
<td>Small</td>
<td>Smallest</td>
</tr>
<tr>
<td>Kernel Mode</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Selecting the Intel IPP Libraries Needed by Your Application

Table 5-9 shows functional domains and the relevant header files and libraries used for each linkage method.

### Table 5-9  Libraries Used for Each Linkage Method

<table>
<thead>
<tr>
<th>Domain Description</th>
<th>Header Files Dynamic Linking</th>
<th>Static Linking with Dispatching and Custom Dynamic Linking</th>
<th>Static Linking without Dispatching</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Coding</td>
<td>ippac.h ippac.lib</td>
<td>ippacmerged.lib</td>
<td>ippacmerged.lib ippacmerged_t.lib</td>
</tr>
<tr>
<td>Domain Description</td>
<td>Header Files</td>
<td>Dynamic Linking</td>
<td>Static Linking with Dispatching and Custom Dynamic Linking</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------</td>
<td>-----------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Color Conversion</td>
<td>ippcc.h</td>
<td>ippcc.lib</td>
<td>ippccemerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>String Processing</td>
<td>ippch.h</td>
<td>ippch.lib</td>
<td>ippcchemerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cryptography</td>
<td>ippcp.h</td>
<td>ippcp.lib</td>
<td>ippcpemerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer Vision</td>
<td>ippcv.h</td>
<td>ippcv.lib</td>
<td>ippcvemerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Compression</td>
<td>ippdc.h</td>
<td>ippdc.lib</td>
<td>ippcdmerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Integrity</td>
<td>ippdi.h</td>
<td>ippdi.lib</td>
<td>ippdiemerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generated Functions</td>
<td>ippsh</td>
<td>ippgen.lib</td>
<td>ippgenemerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Processing</td>
<td>ippih</td>
<td>ippi.lib</td>
<td>ippiemerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Compression</td>
<td>ippjih</td>
<td>ippj.lib</td>
<td>ippjemerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Realistic Rendering and 3D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Processing</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Dynamic Linkage

To use the dynamic linking libraries, you must link to ipp*.lib files in the \stublib directory, where * denotes the appropriate function domain. You must also link to all corresponding domain libraries used in your applications plus the libraries ipps.lib, ippcore.lib, and libiomp5md.lib.

For example, consider that your application uses three Intel IPP functions ippiCopy_8u_C1R,ippiCanny_16s8u_C1R, and ippmMul_mc_32f. These three functions belong to the image processing, computer vision, and small matrix operations domains, respectively. To include these functions into your application, you must link to the following Intel IPP libraries:

Table 5-9 Libraries Used for Each Linkage Method (continued)

<table>
<thead>
<tr>
<th>Domain Description</th>
<th>Header Files</th>
<th>Dynamic Linking</th>
<th>Static Linking with Dispatching and Custom Dynamic Linking</th>
<th>Static Linking without Dispatching</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Matrix Operations</td>
<td>ippm.h</td>
<td>ippm.lib</td>
<td>ippmemerged.lib</td>
<td>ippmmerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ippmmerged_t.lib</td>
</tr>
<tr>
<td>Signal Processing</td>
<td>ipps.h</td>
<td>ipps.lib</td>
<td>ippsmerged.lib</td>
<td>ippsmerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ippsmerged_t.lib</td>
</tr>
<tr>
<td>Speech Coding</td>
<td>ippsc.h</td>
<td>ippsc.lib</td>
<td>ippscmerged.lib</td>
<td>ippscmerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ippscmerged_t.lib</td>
</tr>
<tr>
<td>Speech Recognition</td>
<td>ippsr.h</td>
<td>ippsr.lib</td>
<td>ippsremerged.lib</td>
<td>ippsrmerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ippsrmerged_t.lib</td>
</tr>
<tr>
<td>Video Coding</td>
<td>ippvc.h</td>
<td>ippvc.lib</td>
<td>ippvmerged.lib</td>
<td>ippvmerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ippvmerged_t.lib</td>
</tr>
<tr>
<td>Vector Math</td>
<td>ippvm.h</td>
<td>ippvm.lib</td>
<td>ippvmerged.lib</td>
<td>ippvmerged.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ippvmerged_t.lib</td>
</tr>
<tr>
<td>Core Functions</td>
<td>ippcore.h</td>
<td>ippcore.lib</td>
<td>ippcore.lib</td>
<td>ippcore.lib</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ippcore_t.lib</td>
</tr>
</tbody>
</table>

5 Intel® IPP User’s Guide
Static Linkage with Dispatching

To use the static linking libraries, you need to link to ipp*emerged.lib, ipp*merged.lib, ippsemerged.lib, ippsmerged.lib, and ippcore.lib. The * denotes the appropriate function domain.

If you want to use the Intel IPP functions threaded with the OpenMP*, you need to link to ipp*emerged.lib, ipp*merged_t.lib, ippsemerged.lib, ippsmerged_t.lib, ippcore_t.lib, and libiomp5mt.lib.

All these libraries are located in the \lib directory containing domain-specific functions. Note that both merged and emerged libraries for all domains plus the signal processing domain must be linked to your application.

For example, consider that your application uses three Intel IPP functionsippiCopy_8u_C1R,ippiCanny_16s8u_C1R, and ippmMul_mc_32f. These three functions belong to the image processing, computer vision, and small matrix operations domains respectively. If you want to use the threaded functions, you must link the following libraries to your application:

ippi.emerged.lib and ippcvemerged.t.lib
ippmm.emerged.lib and ippmmmerged.t.lib
ippi.emerged.lib and ippimerged.t.lib
ippsem.emerged.lib and ippsmerged.t.lib
ippcore.t.lib
libiomp5mt.lib

Library Dependencies by Domain (Static Linkage Only)

Table 5-10 lists library dependencies by domain. When you link to a certain library (for example, data compression domain), you must link to the libraries on which it depends (in our example, the signal processing and core functions).
Table 5-10  Library Dependencies by Domain

<table>
<thead>
<tr>
<th>Domain</th>
<th>Library</th>
<th>Dependent on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Coding</td>
<td>ippac</td>
<td>ippdc, ipp, ippcore</td>
</tr>
<tr>
<td>Color Conversion</td>
<td>ippcc</td>
<td>ippi, ipp, ippcore</td>
</tr>
<tr>
<td>Cryptography</td>
<td>ippcp</td>
<td>ippcore</td>
</tr>
<tr>
<td>Computer Vision</td>
<td>ippcv</td>
<td>ipp, ipp, ippcore</td>
</tr>
<tr>
<td>Data Compression</td>
<td>ippdc</td>
<td>ipp, ippcore</td>
</tr>
<tr>
<td>Data Integrity</td>
<td>ippdi</td>
<td>ippcore</td>
</tr>
<tr>
<td>Generated Functions</td>
<td>ippgen</td>
<td>ipp, ippcore</td>
</tr>
<tr>
<td>Image Processing</td>
<td>ippi</td>
<td>ipp, ippcore</td>
</tr>
<tr>
<td>Image Compression</td>
<td>ippj</td>
<td>ippi, ipp, ippcore</td>
</tr>
<tr>
<td>Small Matrix Operations</td>
<td>ippm</td>
<td>ippi, ipp, ippcore</td>
</tr>
<tr>
<td>Realistic Rendering and 3D Data Processing</td>
<td>ipprr</td>
<td>ippi, ipp, ippcore</td>
</tr>
<tr>
<td>Signal Processing</td>
<td>ipp</td>
<td>ippcore</td>
</tr>
<tr>
<td>Speech Coding</td>
<td>ippsc</td>
<td>ipp, ippcore</td>
</tr>
<tr>
<td>Speech Recognition</td>
<td>ippsr</td>
<td>ipp, ippcore</td>
</tr>
<tr>
<td>String Processing</td>
<td>ippch</td>
<td>ipp, ippcore</td>
</tr>
<tr>
<td>Video Coding</td>
<td>ippvc</td>
<td>ippi, ipp, ippcore</td>
</tr>
<tr>
<td>Vector Math</td>
<td>ippvm</td>
<td>ippcore</td>
</tr>
</tbody>
</table>

Refer to Intel IPP Reference Manuals to find which domain your function belongs to.

**Linking Examples**

For more linking examples, please go to http://www.intel.com/software/products/ipp/samples.htm

For information on using sample code, please see "Intel® IPP Samples".
This chapter discusses the use of Intel® IPP in multithreading applications.

**Intel IPP Threading and OpenMP* Support**

All Intel IPP functions are thread-safe in both dynamic and static libraries and can be used in the multithreaded applications.

Some Intel IPP functions contain OpenMP* code that increases significantly performance on multi-processor and multi-core systems. These functions include color conversion, filtering, convolution, cryptography, cross correlation, matrix computation, square distance, and bit reduction, etc.

Refer to the `ThreadedFunctionsList.txt` document to see the list of all threaded functions in the \doc directory of the Intel IPP installation.

See also [http://www.intel.com/software/products/support/ipp](http://www.intel.com/software/products/support/ipp) for more topics related to Intel IPP threading and OpenMP* support, including older Intel IPP versions of threaded API.

**Setting Number of Threads**

The default number of threads for Intel IPP threaded libraries is equal to the number of processors in the system and does not depend on the value of the OMP_NUM_THREADS environment variable.

To set another number of threads used by Intel IPP internally, call the function ippSetNumThreads(n) at the very beginning of an application. Here n is the desired number of threads (1,...). If internal parallelization is not desired, call ippSetNumThreads(1).
Using Shared L2 Cache

Some functions in the signal processing domain are threaded on two threads intended for the Intel® Core™2 processor family, and exploit the advantage of a merged L2 cache. These functions (single and double precision FFT, Div, Sqrt, and so on) achieve the maximum performance if both two threads are executed on the same die. In this case, these threads work on the same shared L2 cache. For processors with two cores on the die, this condition is satisfied automatically. For processors with more than two cores, a special OpenMP environmental variable must be set:

KMP_AFFINITY=compact

Otherwise, the performance may degrade significantly.

Nested Parallelization

If the multithreaded application created with OpenMP uses the threaded Intel IPP function, this function will operate in a single thread because the nested parallelization is disabled in OpenMP by default.

If the multithreaded application created with other tools uses the threaded Intel IPP function, it is recommended that you disable multithreading in Intel IPP to avoid nested parallelization and to avoid possible performance degradation.

Disabling Multithreading

To disable multi-threading, call function ippSetNumThreads with parameter 1, or link your application with IPP non-threaded static libraries.
Managing Performance and Memory

This chapter describes ways you can get the most out of the Intel® IPP software such as aligning memory, thresholding denormal data, reusing buffers, and using Fast Fourier Transform (FFT) for algorithmic optimization (where appropriate). Finally, it gives information on how to accomplish the Intel IPP functions performance tests by using the Intel IPP Performance Test Tool and it gives some examples of using the Performance Tool Command Lines.

Memory Alignment

The performance of Intel IPP functions can be significantly different when operating on aligned or misaligned data. Access to memory is faster if pointers to the data are aligned.

Use the following Intel IPP functions for pointer alignment, memory allocation and deallocation:

```c
void* ippAlignPtr( void* ptr, int alignBytes )
    Aligns a pointer, can align to 2/4/8/16/…
void* ippMalloc( int length )
    32-byte aligned memory allocation. Memory can be freed only with the function ippFree.
void ippFree( void* ptr )
    Frees memory allocated by the function ippMalloc.
Ipp<datatype>* ippsMalloc_<datatype>( int len )
    32-byte aligned memory allocation for signal elements of different data types. Memory can be freed only with the function ippsFree.
void ippsFree( void* ptr )
    Frees memory allocated by ippsMalloc.
Ipp<datatype>* ippiMalloc_<mod>(int widthPixels, int heightPixels, int* pStepBytes)
    32-byte aligned memory allocation for images where every line of the image is…
```
padded with zeros. Memory can be freed only with the function ippiFree.

```c
void ippiFree( void* ptr )
```

Frees memory allocated by ippiMalloc.

Example 7-1 demonstrates how the function ippiMalloc can be used. The amount of memory that can be allocated is determined by the operating system and system hardware, but it cannot exceed 2GB.

NOTE. Intel IPP memory functions are wrappers of the standard malloc and free functions that align the memory to a 32-byte boundary for optimal performance on the Intel architecture.

NOTE. The Intel IPP functions ippFree, ippsFree, and ippiFree can only be used to free memory allocated by the functions ippMalloc, ippsMalloc and ippiMalloc, respectively.

NOTE. The Intel IPP functions ippFree, ippsFree, and ippiFree cannot be used to free memory allocated by standard functions like malloc or calloc; nor can the memory allocated by the Intel IPP functions ippMalloc, ippsMalloc, and ippiMalloc be freed by the standard function free.
Thresholding Data

Denormal numbers are the border values in the floating-point format and special case values for the processor. Operations on denormal data make processing slow, even if corresponding interrupts are disabled. Denormal data occurs, for example, in filtering by Infinite Impulse Response (IIR) and Finite Impulse Response (FIR) filters of the signal captured in fixed-point format and converted to the floating-point format. To avoid the slowdown effect in denormal data processing, the Intel IPP threshold functions can be applied to the input signal before filtering. For example:

```c
if (denormal_data)
    ippsThreshold_LT_32f_I( src, len, 1e-6f );
    ippsFIR_32f( src, dst, len, st );
```

---

Example 7-1  Calling the ippiMalloc function

```c
#include "stdafx.h"
#include "ipp.h"
#include "tools.h"

int main(int argc, char *argv[])
{
    IppiSize size = {320, 240};

    int stride;
    Ipp8u* pSrc = ippiMalloc_8u_C3(size.width, size.height, &stride);
    ippiImageJaehne_8u_C3R(pSrc, stride, size);
    ipView_8u_C3R(pSrc, stride, size, "Source image", 0);

    int dstStride;
    Ipp8u* pDst = ippiMalloc_8u_C3(size.width, size.height, &dstStride);
    ippiCopy_8u_C3R(pSrc, stride, pDst, dstStride, size);
    ipView_8u_C3R(pDst, dstStride, size, "Destination image 1", 0);

    IppSize ROISize = { size.width/2, size.height/2 };
    ippiCopy_8u_C3R(pSrc, stride, pDst, dstStride, ROISize);
    ipView_8u_C3R(pDst, dstStride, ROISize, "Destination image, small", 0);

    IppiPoint srcOffset = { size.width/4, size.height/4 };
    ippiCopy_8u_C3R(pSrc + srcOffset.x*3 + srcOffset.y*stride, stride,
                    pDst, dstStride, ROISize);
    ipView_8u_C3R(pDst, dstStride, ROISize, "Destination image, small &
                    shifted", 1);

    return 0;
}
```
The $1e^{-6}$ value is the threshold level; the input data below that level are set to zero. Because the Intel IPP threshold function is very fast, the execution of two functions is faster than execution of one if denormal numbers meet in the source data. Of course, if the denormal data occurs while using the filtering procedure, the threshold functions do not help.

In this case, for Intel processors beginning with the Intel® Pentium® 4 processor, it is possible to set special computation modes - flush-to-zero (FTZ) and the denormals-are-zero (DAZ). You can use functions `ippsSetFlushToZero` and `ippsSetDenormAreZeros` to enable these modes. Note that this setting takes effect only when computing is done with the Intel® Streaming SIMD Extensions (Intel® SSE) and Intel Streaming SIMD Extensions 2 (Intel SSE2) instructions.

*Table 7-1* illustrates how denormal data may affect performance and it shows the effect of thresholding denormal data. As you can see, thresholding takes only three clocks more. On the other hand, denormal data can cause the application performance to drop 250 times.

<table>
<thead>
<tr>
<th>Table 7-1 Performance Resulting from Thresholding Denormal Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data/Method</strong></td>
</tr>
<tr>
<td>-----------------</td>
</tr>
<tr>
<td><strong>CPU cycles per element</strong></td>
</tr>
</tbody>
</table>

**Reusing Buffers**

Some Intel IPP functions require internal memory for various optimization strategies. At the same time, you should be aware that memory allocation inside of the function may have a negative impact on performance in some situations, such as in the case of cache misses. To avoid or minimize memory allocation and keep your data in warm cache, some functions, for example, Fourier transform functions, can use or reuse memory given as a parameter to the function.

If you have to call a function, for example, an FFT function, many times, the reuse of an external buffer results in better performance. A common example of this kind of processing is to perform filtering using FFT, or to compute FFT as two FFTs in two separate threads:

```c
ippsFFTInitAlloc_C_32fc( &ctxN2, order-1, IPP_FFT_DIV_INV_BY_N, ippAlgHintAccurate );

ippsFFTGetSize_C_32fc( ctxN2, &sz );
buffer = sz > 0 ? ippsMalloc_8u( sz ) : 0;

int phase = 0;
```
Managing Performance and Memory

/// prepare source data for two FFTs

```c
ippsSampleDown_32fc( x, fftlen, xleft, &fftlen2, 2, &phase );
phase = 1;
ippsSampleDown_32fc( x, fftlen, xrght, &fftlen2, 2, &phase );
```

```c
ippsFFTFwd_CToC_32fc( xleft, Xleft, ctxN2, buffer );
ippsFFTFwd_CToC_32fc( xrght, Xrght, ctxN2, buffer );
```

The external buffer is not necessary. If the pointer to the buffer is 0, the function allocates memory inside.

## Using FFT

Fast Fourier Transform (FFT) is a universal method to increase performance of data processing, especially in the field of digital signal processing where filtering is essential.

The convolution theorem states that filtering of two signals in the spatial domain can be computed as point-wise multiplication in the frequency domain. The data transformation to and from the frequency domain is usually performed using the Fourier transform. You can apply the Finite Impulse Response (FIR) filter to the input signal by using Intel IPP FFT functions, which are very fast on Intel® processors. You can also increase the data array length to the next greater power of two by padding the array with zeroes and then applying the forward FFT function to the input signal and the FIR filter coefficients. Fourier coefficients obtained in this way are multiplied point-wise and the result can easily be transformed back to the spatial domain. The performance gain achieved by using FFT may be very significant.

If the applied filter is the same for several processing iterations, then the FFT of the filter coefficients needs to be done only once. The twiddle tables and the bit reverse tables are created in the initialization function for the forward and inverse transforms at the same time. The main operations in this kind of filtering are presented below:

```c
ippsFFTInitAlloc_R_32f( &pFFTSpec, fftord, IPP_FFT_DIV_INV_BY_N,
ippAlgHintNone );
```

```c
/// perform forward FFT to put source data xx to frequency domain
ippsFFTFwd_RToPack_32f( xx, XX, pFFTSpec, 0 );
```

```c
/// perform forward FFT to put filter coefficients hh to frequency domain
```
Another way to significantly improve performance is by using FFT and multiplication for processing large size data. Note that the zeros in the example above could be pointers to the external memory, which is another way to increase performance. Note that the Intel IPP signal processing FIR filter is implemented using FFT and you do not need to create a special implementation of the FIR functions.

Running Intel IPP Performance Test Tool

The Intel IPP Performance Test Tool is available for Windows* operating systems based on Intel® Pentium® processors and Intel® Itanium® processors. It is a fully-functioned timing system designed to do performance testing for Intel IPP functions on the same hardware platforms that are valid for the related Intel IPP libraries. It contains command line programs for testing the performance of each Intel IPP function in various ways.

You can use command line options to control the course of tests and generate the results in a desirable format. The results are saved in a .csv file. The course of timing is displayed on the console and can be saved in a .txt file. You can create a list of functions to be tested and set required parameters with which the function should be called during the performance test. The list of functions to be tested and their parameters can either be defined in the .ini file, or entered directly from the console.

In the enumeration mode, the Intel IPP performance test tool creates a list of the timed functions on the console and in the .txt or .csv files.

Additionally, this performance test tool provides all performance test data in the .csv format. It contains data covering all domains and CPU types supported in Intel IPP. For example, you can read that reference data in sub-directory \tools\perfsys\data.

Once the Intel IPP package is installed, you can find the performance test.exe files located in the \ia32\tools\perfsys directory. For example, ps_ipps.exe is a tool to measure performance of the Intel IPP signal processing functions. Similarly, there are the appropriate executable files for each Intel IPP functional domain.
The command line format is:

<ps_fileName>.exe [option_1] [option_2] ... [option_n]

A short reference for the command line options can be displayed on the console. To invoke the reference, just enter -? or -h in the command line:

ps_ipps.exe -h

The command line options can be divided into six groups by their functionality. You can enter options in an arbitrary order with at least one space between each option name. Some options (like -r, -R, -o, -O) may be entered several times with different file names, and option -f may be entered several times with different function patterns. For detailed descriptions of the performance test tool command line options, see Appendix A, “Performance Test Tool Command Line Options”.

Examples of Using Performance Test Tool Command Lines

The following examples illustrate how you can use common command lines for the performance test tool to generate IPP function performance data.

Example 1. Running in the standard mode:

ps_ippch.exe -B -r

This command causes all Intel IPP string functions to be tested by the default timing method on standard data (-B option). The results will be generated in file ps_ippch.csv (-r option).

Example 2. Testing selected functions:

ps_ipps.exe -f FIRLMS_32f -r firlms.csv

This command tests the FIR filter function FIRLMS_32f (-f option), and generates a .csv file named firlms.csv (-r option).

Example 3. Retrieving function lists:

ps_ippvc.exe -e -o vc_list.txt

This command causes the output file vc_list.txt (-o option) to list all Intel IPP video coding functions (-e option).

ps_ippvc.exe -e -r H264.csv -f H264

This command causes the list of functions with names containing H264 (-f option) that can be tested (-e option) to be displayed on the console and stored in file H264.csv (-r option).
Example 4. Launching performance test tool with the .ini file:

```
ps_ipps.exe -B -I
```
This command causes the .ini file `ps_ipps.ini` to be created after the first run (`-I` option) to test all signal processing functions using the default timing method on standard data (`-B` option).

```
ps_ippi.exe -i -r
```
This command causes the second run to test all functions using the timing procedure and all function parameters values specified in the `ps_ipps.ini` file (`-i` option) and generates the output file `ps_ipps.csv` (`-r` option).

For detailed descriptions of performance test tool command line options, see Appendix A, "Performance Test Tool Command Line Options".
This chapter describes how to use Intel IPP with different programming languages in the Windows*OS development environments, and gives information on relevant samples.

Language Support

In addition to the C programming language, Intel IPP functions are compatible with the following languages (download the samples from http://www.intel.com/software/products/ipp/samples.htm):

<table>
<thead>
<tr>
<th>Language</th>
<th>Environment</th>
<th>The Sample Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C++</td>
<td>Makefile</td>
<td>The sample shows how Intel IPP C-library functions can be overloaded in the C++ interface to create classes for easy signal and image manipulation.</td>
</tr>
<tr>
<td></td>
<td>Microsoft* eMbedded</td>
<td>The sample shows how to use the Intel IPP libraries in the development of applications for the Windows* CE environment for x86.</td>
</tr>
<tr>
<td></td>
<td>Visual C++* 4.0, or higher</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WinCE 5.0 SDK for x86</td>
<td></td>
</tr>
<tr>
<td>Fortran</td>
<td>Makefile</td>
<td>N/A</td>
</tr>
<tr>
<td>C#*</td>
<td>Microsoft .NET C#*</td>
<td>The sample shows how to use the Intel IPP functions in a C# wrapper class.</td>
</tr>
<tr>
<td>Visual Basic*</td>
<td>Microsoft .NET Visual Basic*</td>
<td>The demo-application shows how to call Intel IPP functions from a Visual Basic wrapper class.</td>
</tr>
<tr>
<td>Object Pascal</td>
<td>Borland Delphi*</td>
<td>The sample shows how to use Intel IPP image processing primitives in Borland Delphi*.</td>
</tr>
</tbody>
</table>
Using Intel IPP in Java* Applications

You can call Intel IPP functions in your Java application by using the Java* Native Interface (JNI*). There is some overhead associated with JNI use, especially when the input data size is small. Combining several functions into one JNI call and using managed memory will help improve the overall performance.

Table 8-1 Language support (continued)

<table>
<thead>
<tr>
<th>Language</th>
<th>Environment</th>
<th>The Sample Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java*</td>
<td>Java Development Kit 1.5.0</td>
<td>The sample shows how to use the Intel IPP image processing functions in a Java wrapper class.</td>
</tr>
</tbody>
</table>
Table A-1 gives brief descriptions of possible command line options for the performance test tool (PTT).

<table>
<thead>
<tr>
<th>Groups</th>
<th>Options</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Adjusting Console Input</td>
<td>-A</td>
<td>Ask parameters before every test from console</td>
</tr>
<tr>
<td></td>
<td>-B</td>
<td>Batch mode</td>
</tr>
<tr>
<td></td>
<td>-r[&lt;file-name&gt;]</td>
<td>Create .csv file and write PS results</td>
</tr>
<tr>
<td></td>
<td>-R[&lt;file-name&gt;]</td>
<td>Add test results to .csv file</td>
</tr>
<tr>
<td></td>
<td>-H[ONLY]</td>
<td>Add 'Interest' column to table file [and run only hot tests]</td>
</tr>
<tr>
<td>2. Managing Output</td>
<td>-o[&lt;file-name&gt;]</td>
<td>Create .txt file and write console output</td>
</tr>
<tr>
<td></td>
<td>-O[&lt;file-name&gt;]</td>
<td>Add console output to .txt file</td>
</tr>
<tr>
<td></td>
<td>-L&lt;ERR</td>
<td>WARN</td>
</tr>
<tr>
<td></td>
<td>-u[&lt;file-name&gt;]</td>
<td>Create .csv file and write summary table ('_sum' is added to default title name)</td>
</tr>
<tr>
<td></td>
<td>-U[&lt;file-name&gt;]</td>
<td>Add summary table to .csv file ('_sum' is added to default title name)</td>
</tr>
<tr>
<td></td>
<td>-e</td>
<td>Enumerate tests and exit</td>
</tr>
<tr>
<td></td>
<td>-g[&lt;file-name&gt;]</td>
<td>Signal file is created just at the end of the whole testing</td>
</tr>
<tr>
<td></td>
<td>-s[-]</td>
<td>Sort or don't sort functions (sort mode is default)</td>
</tr>
<tr>
<td>3. Selecting Functions for Testing</td>
<td>-f &lt;or-pattern&gt;</td>
<td>Run tests of functions with pattern in name, case sensitive</td>
</tr>
<tr>
<td></td>
<td>-f-&lt;not-pattern&gt;</td>
<td>Do not test functions with pattern in name, case sensitive</td>
</tr>
<tr>
<td>Groups</td>
<td>Options</td>
<td>Descriptions</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>4. Operation with .ini Files</td>
<td>-f+&lt;and-pattern&gt;</td>
<td>Run only tests of functions with pattern in name, case sensitive</td>
</tr>
<tr>
<td></td>
<td>-f=&lt;eq-pattern&gt;</td>
<td>Run tests of functions with this full name, case sensitive</td>
</tr>
<tr>
<td></td>
<td>-F&lt;func-name&gt;</td>
<td>Start testing from function with this full name, case sensitive</td>
</tr>
<tr>
<td></td>
<td>-i[&lt;file-name&gt;]</td>
<td>Read PTT parameters from .ini file</td>
</tr>
<tr>
<td></td>
<td>-I[&lt;file-name&gt;]</td>
<td>Write PTT parameters to .ini file and exit</td>
</tr>
<tr>
<td></td>
<td>-P</td>
<td>Read tested function names from .ini file</td>
</tr>
<tr>
<td>5. Adjust default directories and file names for input &amp; output</td>
<td>-n&lt;title-name&gt;</td>
<td>Set default title name for .ini file and output files</td>
</tr>
<tr>
<td></td>
<td>-p&lt;dir-name&gt;</td>
<td>Set default directory for .ini file and input test data files</td>
</tr>
<tr>
<td></td>
<td>-l&lt;dir-name&gt;</td>
<td>Set default directory for output files</td>
</tr>
<tr>
<td>6. Direct Data Input</td>
<td>-d&lt;name&gt;=&lt;value&gt;</td>
<td>Set PTT parameter value</td>
</tr>
<tr>
<td>7. Process priority</td>
<td>-Y&lt;HIGH/NORMAL&gt;</td>
<td>Set high or normal process priority (normal is default)</td>
</tr>
<tr>
<td>8. Setting environment</td>
<td>-N&lt;num-threads&gt;</td>
<td>Call ippSetNumThreads(&lt;num-threads&gt;)</td>
</tr>
<tr>
<td>9. Getting help</td>
<td>-h</td>
<td>Type short help and exit</td>
</tr>
<tr>
<td></td>
<td>-hh</td>
<td>Type extended help and exit</td>
</tr>
<tr>
<td></td>
<td>-h&lt;option&gt;</td>
<td>Type extended help for the specified option and exit</td>
</tr>
</tbody>
</table>

Table A-1 Performance Test Tool Command Line Options (continued)
This appendix describes the types of Intel® IPP sample code available for developers to learn how to use Intel IPP, gives the source code example files by categories with links to view the sample code, and explains how to build and run the sample applications.

For information on configuring Microsoft* Visual* C++ project files for the Intel IPP samples, see “Creating Visual C++ 2005 Project Files for the Intel® IPP Samples”.

For information on generating Microsoft Visual C++ .NET project and solution files for Intel IPP UMC sample code, see “Building a Microsoft* Visual C++ .NET* Solution for the UMC Sample Code”.

Types of Intel IPP Sample Code

There are three types of Intel IPP sample code available for developers to learn how to use the Intel Integrated Performance Primitives. Each type is designed to demonstrate how to build software with the Intel IPP functions. All types are listed in Table B-1.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application-level samples</td>
<td>These samples illustrate how to build a wide variety of applications such as encoders, decoders, viewers, and players using the Intel IPP APIs.</td>
</tr>
<tr>
<td>Source Code Samples</td>
<td>These platform independent examples show basic techniques for using Intel IPP functions to perform such operations as performance measurement, time-domain filtering, affine transformation, canny edge detection, and more. Each example consists of 1-3 source code files (.cpp).</td>
</tr>
<tr>
<td>Code examples</td>
<td>These code examples (or code snippets) are very short programs demonstrating how to call a particular Intel IPP function. Numerous code examples are contained in the Intel IPP Manual (.pdf) as part of the function descriptions.</td>
</tr>
</tbody>
</table>
NOTE. Intel IPP samples are intended only to demonstrate how to use the APIs and how to build applications in different development environments.

Source Code Samples

Table B-2 presents the list of files with source code for the Intel IPP samples. All these samples are created for Windows OS, but they can be easily adapted for Linux OS.

Table B-2 Source Files of the Intel IPP Sample Code

<table>
<thead>
<tr>
<th>Category</th>
<th>Summary</th>
<th>Description and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Techniques</td>
<td>Introduction to programming with Intel IPP functions</td>
<td>Performance measurement:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Copying data: Copy.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Optimizing table-based functions: LUT.cpp</td>
</tr>
<tr>
<td>Digital Filtering</td>
<td>Fundamentals of signal processing</td>
<td>Executing the DFT: DFT.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Filtering with FFT: FFTFilter.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time-domain filtering: FIR.cpp</td>
</tr>
<tr>
<td>Audio Processing</td>
<td>Audio signal generation and manipulation</td>
<td>Generating DTMF tones: DTMF.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Using IIR to create an echo: IIR.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Using FIRMR to resample a signal: Resample.cpp</td>
</tr>
<tr>
<td>Image Processing</td>
<td>Creating and processing a whole image or part of an image</td>
<td>Allocating, initializing, and copying an image: Copy.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rectangle of interest sample wrapper: ROI.h ROI.cpp ROITest.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mask image sample wrapper: Mask.h Mask.cpp MaskTest.cpp</td>
</tr>
</tbody>
</table>
### Table B-2 Source Files of the Intel IPP Sample Code (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Summary</th>
<th>Description and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Filtering and Manipulation</td>
<td>General image affine transformations</td>
<td>• Wrapper for resizing an image:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* Resize.h    Resize.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* ResizeTest.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Wrapper for rotating an image:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* Rotate.h      Rotate.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* RotateTest.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Wrapper for doing an affine transform on an image:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* Affine.h      Affine.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* AffineTest.cpp</td>
</tr>
<tr>
<td>Graphics and Physics</td>
<td>Vector and small matrix arithmetic functions</td>
<td>• ObjectViewer application:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* ObjectViewerDoc.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* ObjectViewerDoc.h</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* ObjectViewerView.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>* ObjectViewerView.h</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transforming vertices and normals:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTestView::OnMutateModel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Projecting an object onto a plane:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTestView::OnProjectPlane</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Drawing a triangle under the cursor:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CTestView::Draw</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Performance comparison, vector vs. scalar:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>perform.cpp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Performance comparison, buffered vs. unbuffered:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>perform2.cpp</td>
</tr>
</tbody>
</table>
Using Intel IPP Samples


These application-level samples are updated in each version of Intel IPP. It is strongly recommended that you upgrade the Intel IPP Samples when a new version of Intel IPP is available.

Several common samples are included with the product. You can find them in the <ipp directory>\samples.

System Requirements

Refer to the readme.htm document in the root directory of each sample to learn the system requirements for the specific sample. Most common requirements are listed below.

Hardware requirements:

- A system based on an Intel® Pentium® processor, Intel® Xeon® processor, or a subsequent IA-32 architecture-based processor

Software requirements:

- Intel® IPP for the Windows* OS, version 6.1
- Microsoft* DirectX* API: 9.0 SDK Update (February 2005) or SDK (December 2005)
- Intel® C++ Compiler for Windows® OS: versions 11.1, 11.0 or 10.1, Intel® Parallel Composer

- When building for a processor supporting the Intel® 64 architecture, the Microsoft EM64T Platform SDK is required.
- When building for an Intel® Itanium® 2 processor, the Platform SDK for Microsoft Windows Server 2003 SP1 is required.
- Microsoft eMbedded Visual C++ 4.0 tool with Service Pack 4 (SP4).
- When building for the Windows CE OS version 5.0 for x86, the Standard Software Development Kit (SDK) for Windows CE 5.0 operating system is required.

### Building Source Code

The building procedure is described in the readme.htm document for each sample. Most common steps are described below.

Set up your build environment by creating an environment variable named IPPROOT that points to the root directory of your Intel IPP installation. For example: C:\Program Files\Intel\IPP\6.1.x.xxx\ia32\.

To build the sample, change your current folder to the root sample folder and run batch file build32.bat [option].

By default, the batch file searches the compilers step by step according to the table below (assuming that compiler is installed in the default directory). If you wish to use a specific version of the Intel C/C++ compiler or the Microsoft C/C++ .NET 2005 compiler, set an option for the batch file from the table below.

<table>
<thead>
<tr>
<th>Compiler</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel C++ Compiler 11.1 for Windows OS</td>
<td>icl1111</td>
</tr>
<tr>
<td>Intel C++ Compiler 11.0 for Windows OS</td>
<td>icl1110</td>
</tr>
<tr>
<td>Intel C++ Compiler 10.1 for Windows OS</td>
<td>icl1101</td>
</tr>
<tr>
<td>Intel Parallel Composer</td>
<td>ipc2009</td>
</tr>
<tr>
<td>Microsoft Visual C++ .NET 2008 software</td>
<td>cl9</td>
</tr>
</tbody>
</table>
After the successful build, the result file or files are placed in the corresponding sample directory: `<install_dir>\ipp-samples\sample-name\bin\win32_<compiler>`, where compiler = cl7|cl8|cl9|ipc2009|icl101|icl110|icl111.

### Running the Software

To run each sample application, the Intel IPP dynamic link libraries must be on the system's path. See "Setting Environment Variables" for more details.

Refer to the `readme.htm` document in the directory of the specific sample for detailed instructions on how to run the application, the list of command line options, or menu commands.

### Known Limitations

The applications created with the Intel IPP Samples are intended to demonstrate how to use the Intel IPP functions and help developers to create their own software. These sample applications have some limitations that are described in the section "Known Limitations" in the `readme.htm` document for each sample.
Index

**B**
building application, 2-9
building samples, B-5

**C**
calling functions, 2-10
checking your installation, 2-8
configuring environment, 4-1
controlling number of threads, 6-1

**D**
detecting processor type, 5-2
Disabling Multithreading, 6-2
dispatching, 5-1
document
  audience, 1-3
  filename, 3-4
  location, 3-1
  organisation, 1-4
  purpose, 1-2

**H**
header files, 2-10

**I**
Intel® IPP, 1-1
IntelliSence capability, 4-3
IntelliSense, in Visual Studio IDE, 4-3

**J**
java applications, 8-2

**L**
language support, 8-1
library dependencies by domain, 5-13
linking
  custom dynamic, 5-9
  dynamic, 5-5
  static, with dispatching, 5-5
  static, without dispatching, 5-7
linking examples, 5-14
linking models, 5-4
linking models comparison, 5-10

**M**
managing performance, 7-1
  memory alignment, 7-1
  reusing buffers, 7-4
  thresholding data, 7-3
  using FFT, 7-5
memory alignment, 7-1

**N**
notational conventions, 1-5

**O**
OpenMP support, 6-1
P
performance test tool, 7-6
  command line examples, 7-7
  command line options, A-1
processor-specific codes, 5-1

R
reusing buffers, 7-4
running samples, B-4
  known limitations, B-6

S
Sample, B-1
samples
  types, B-1
selecting
  libraries, 5-10
  linking models, 5-4
setting environment variables, 2-9
source code samples, B-2
structure
  by library types, 3-2
  documentation directory, 3-4
  high-level directory, 3-1
supplied libraries, 3-2

T
technical support, 1-1
threading, 6-1
thresholding data, 7-3

U
UMC sample code, 4-2
using
  DLLs, 3-2
  static libraries, 3-3
using FFT, 7-5
using Intel IPP
  with compilers, 4-6
  with Java, 8-2

V
version information, 2-9